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 Attend this session for a new way to learn and possibly win a prize. 

 We will be running a game of Inventor Jeopardy, Where the points in fact do matter.  

 Ever wonder why something you have done before no longer works? Ever try to get 

something done easily but don’t know where to click to make it happen?  How about a 

simple work flow that should happen in two clicks when you are doing it in 20?  

 Here is your chance to learn in a competitive environment and have a great time doing 

it.  This will be more than a clicks and tips session, it will be a knowledge war where we 

all win something.  

Class summary



At the end of this class, you will be able to:

 Leave with at least 5 buttons you have never thought about using!

 Realize some of your work flows can be simplified by choosing the correct tool or 

hidden button.

 Show off your new found hidden stuff to those that did not come to AU.

 Comprehend the value of paying attention to the dialog boxes, they are not wallpaper

Key learning objectives



Section/chapter title slide



I have two sheet metal vendors. One
vendor’s results always match my designs.
The other’s folds are always off by a bit.

What should I do?

A:  The vendor is messed up, find a 
different one.

B: Create a new unfold rule for the 
wayward vendor.

C:  This is always a problem with sheet 
metal, work around it.

D:  Go to application options and modify 
sheet metal settings.



B: Create a new unfold rule for the
wayward vendor.

The sheet metal rule is used to create
the flat pattern based on the
fabricator’s tooling. Work with the
vendor to create a sheet metal rule that
yields what you need.

Go to the sheet metal tab
1. Sheet metal defaults
2. Pencil next to rule
3. Create a new rule or modify an

existing rule



B: Create a new unfold rule for the
wayward vendor.

Another way to get to the sheet metal
rules is under the manage tab.
1. Select manage tab
2. Select styles editor
3. Modify or create a new rule



 Page left Intentionally blank



I have an assembly that I downloaded
from a vendor. Great getting content,
but not so great since the parts are
named Part1, Part2, Part3, …
How do I get out of this mess?

A:  Delete all the other parts in my 
workspace with the same names.

B: Rename each part with Design 
Assistant.  

C:  Derive a new part from the assembly..

D:  Ask the vendor for a better model.



C:  Derive a new part from the 
assembly.

You could have renamed each part in
the assembly. This would have kept the
individual parts usable as parts.

However if you have downloaded the
assembly to use as purchased, you do
not need to spend the time “playing”
with the offending assembly.

Derive a new part from the assembly.
This will have the same shape without
naming conflicts.

Then break the link with the base
component.



I want to send my customer a model that
contains details that he needs, but not to
much so that he gets confused or can rip
off all my work.
Oh by the way, he also uses dialup.
What tool do I use?

A:  Derived parts

B: Part suppression and representations

C:  Visibility and enable

D:  Shrink wrap



D:  Shrink wrap

Shrink wrap with simplicity will get it
done. Small file size, Hide the details,
Get the idea across.

With the assembly open, go to the
Simplify tab. Select the operation that
best suits your need.



I need to send my customer a 3D model
so he can see what I am talking about.

He is at a facility that will not allow him
to install Design Review. So I want to
send him a 3D PDF. What tool do I use?

A:  3DS Max

B: Showcase

C:  Inventor Studio

D:  Inventor Publisher



D:  Inventor Publisher

Not as useful as a DWF, but in a pinch it
gets it done.



What tool do I use to get real time, high
quality renderings?

Also quickly experiment with visual
changes to material, textures, colors and
more.

A:  Showcase

B: Photoshop

C:  Inventor Studio

D:  Inventor Publisher
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A:  Showcase

Simple to use, fast for quick beauty
shots and simple videos.

Ray Tracing is also simple.

Once the assembly is imported you can
change the appearance in a moment.

Create great looking presentations in a
fraction of the time of other imaging
tools.



We are used to being able to constrain
the shaft of this piston to the cylinder.
Also limiting the motion of the shaft to
match the real assembly. Now with 2014
it can be done in one dialog box.
What is it?

A:  iAssembly

B: iLogic

C:  iDon’t know

D:  Joints



A:  Joints

Joint not only enables new constraint
types, but it will also pass along design
intent to analysis tools.



In this assembly I would like to be able to
open and close the trap door. This
means that the piston with the arrow
needs to be able to move within the
constrains of its subassembly. What do I
do to make this happen

A:  Locked

B: It can’t be done easily.  Another AUGI 
wish list item.

C:  Bring the Sub-assembly components 
into the assembly and constrain 
them as needed.

D:  Flexible



D:  Flexible

This is another great tool. Turn on
Flexible for sub assemblies. They can
then move as they would if they were
the top level assembly. Constraints and
grounding work as setup in their
assembly.



I am working in the BOM to change
many part’s materials. This is neat since
you can change many parts quickly
without having to open and close each
one individually. However the parts are
grayed out and can not be changed.
Why?

A:  Locked

B: Vaulted and not checked out

C:  iProperties

D:  Constrained



B:  Vaulted and not checked out.
Items that are not checked out can not
be changed.
Bonus note: to change materials, open 
the BOM, RMC title bar to be able to 
select Runtime Column Customization, 
then drag and drop the Material into 
the 
heading 
bar.



A part that is used in many assemblies
has just been discontinued by our
supplier. I now need to find where it is
used and replace it with the new part.
How can it be done in just a few
minutes?

A:  Vault

B: Windows Explorer

C:  It can’t be done easily.  So sit back, let 
your wife know you won’t be home 
for dinner, again, then use the Find 
tool.

D:  Design Accelerator 



A:  Vault

Vault is such a cool tool. And it is free.
Even if you are a single seat and don’t
share material with others you should
be using Vault.

In this example you could find and
replace all the discontinued occurrences
in just a few minutes. This is one of
MANY cool Vault tools.

Process:
Find the part in the Vault, go to the
“Where Used” tab, drop the Edit tab,
then select “replace”. Then follow the
instructions.



You get a warning when you open an
assembly that you have unresolved links.
Any idea what might have happened?
One possibility is:

A:  Application settings are not 
configured correctly

B: Project selection is messed up.

C:  You need more RAM.  You are running 
out of memory before the files can 
be loaded.

D:  The new intern has been 
experimenting after hours again.
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B:  The Project is not set to your 
workspace

When opening an assembly, Inventor
looks to the workspace for the required
parts and sub assemblies. If the project
selection has gotten messed up these
errors will happen. Also if you don’t
save your parts and assemblies in the
workspace this will also happen.

Go to the “Get Started” tab, select
Projects, make sure your project is the
one checked.

Note: Another result of this will be if
you don’t see your templates when
creating a new file. The Project points
to where your templates are stored.



You would like to move the yellow part
“31238 loader base proprocess”. But it
won’t move. Why?

A:  It is grounded

B: It is constrained

C:  It is not flexible

D:  Adaptivity



A:  It is grounded.

You can see in the browser there is a
thumbtack on the type icon. This shows
that the part is grounded. Also if you
hover the mouse over the part, the
cursor turns into a thumbtack. Also
indicating its being grounded.

If you selected constrained, you were
not necessarily wrong. If another part
in the assembly was adaptive and linked
to the yellow base it would not move.
You would need to turn off the
adaptivity.



You need to place a dimension from the
hole center to the intersection of the
two angled sides. There is a tool that can
do this quickly without needing to
create a sketch. What is it?

A:  This is a trick question.  You need to 
draw a sketch

B: Make a new part including the 
intersection.

C:  Intersection tool

D:  Call for pizza, it will be a long night



C:  Intersection tool

The Intersection tool is found with a
RMC after selecting one leg of the
intersecting lines.

RMC



You have a right handed assembly that
that needs to be mirrored and modified.

To modify it successfully, it will need to
be constrained as before. Can you do
this quickly?

A:  No, you will need to re constrain the 
like the original assembly 

B: Use Vault to mirror constrained

C:  Use Derive to create a new assembly

D:  Get Inventor 2014



D:  Get 2014

With 2014 one of the great new
features is the ability to mirror and keep
the new assembly constrained. Note in
this mirrored demo the new parts are
constrained like the originals.



We just got some files in from our sister
company. As you can tell by the browser
details, there are none. Those guys are a
freaking mess. What tool can I use to try
and figure out what their intent was with
this part? Or at least see what they did?

A:  Vault

B: Design Review

C:  Psycotherapy

D:  EOP (end of part)



D:  End of Part  - EOP

If you drag the “End of Part” up the
browser tree features will suppressed. I
find working my way through the part,
step by step, I can get an idea of what
the other team was thinking, if they
were.

When done, just drag the EOB back to
the end.



In this drawing I would like to show the
model without the light curtain. Instead
of creating new assembly states I want to
just turn the visibility off for some of the
components. Notice in the RMC on the
selected items that the visibility
command is grayed out. Why?

A:  Edit View needs changes

B: Can’t be done.  Need to create new 
assembly details

C:  Go to the view tab, use the isolate 
command

D:  Use BOM to make the changes 
needed.



A:  Edit View

Edit the view command (see below). In
the Drawing View dialog box uncheck
the Associative box. This will enable
you to control the visibility of individual
items.



While working on this assembly you
need to look at the bearings and spacer
inside the spindle. What tool can you
use to move constrained parts out of the
way?

A:  Edit View

B: Can’t be done.  Need to suppress 
constraints to get this done

C:  Go to the view tab, use the isolate 
command

D:  Free Move tool



D:  Free Move Tool
RMC any part, select the “Free Move”
tool. Now you can move parts out of
the way. Constraints are not lost, just
temporarily suppressed. When you turn
the tool off and move any part, they all
snap back in place.



You have brought a DWG into a part
sketch. When you go to extrude features
you find that what appears to be closed
loops are not. There are no constraints
at all. Every line and arc is on its own.
What went wrong?

A:  Get an intern to spend hours closing
loops and constraining.  Productivity 
takes a hit, but your company is 
helping with job creation.

B: Import settings need to be 
configured.

C:  Export from Autocad all on one layer, 
they will automatically constrain 
when placed in the sketch.

D:  Document settings.  Turn on the Auto 
connect with the parasitic auto 
processing doohicky.



B:  Import settings need to be 
configured.

After you select the DWG file for import,
the dialog box shown on the right
comes up.

There are a number of check boxes that
will make your imported data more
usable. In particular, the check box
shown will solve most of the closed area
issues.



I have a .step file from a vendor. When I
open it and Inventor creates an .ipt or
.iam, where do they end up?

A:  Where the .step file was.

B: Location that I choose.

C:  In the Workspace.

D:  This was a trick question, it can be 
any of the above.



D:  This was a trick question, it can be 
any of the above.

After you select the file to be opened,
the STEP Import Options dialog box
opens. Select the options. Now you
have a choice where the files will go.



You have a part that has the a limited
number of variations. Like this support
bracket. Instead of drawing the part
over and over for different cases, what
could you use to get it done quickly?

A:  iParts

B: iMagic

C:  I Don’t know

D:  iDesign



A:  iPart

While iDesign and iMagic do not yet
exist, iPart is one of my iLove tools.

One common question I get is when to
use iPart vs iLogic

If you have a smaller set of parts that
have limited number of variations iPart
is my choice. If the set size is large with
many variables and children, iLogic is
better suited.



You want your hole table to look like the
one on the right. Each hole type has a
single description. Not line after line of
the same info. How do you get this
magic to appear?

A:  RMC Preferences

B: Template idw/dwg setting

C:  Styles settings - Tables

D:  Hole table setting

assem



D:  Edit the Hole Table

RMC on the table, then go to Edit Hole
Table. In this case I chose “Combine
Notes”. See below.



The IT at your firm got a great price on a
new phone carrier, the only issue is the
area code is different. Do you make the
intern change all the legacy idw and
dwg’s? Or do you show off and get it
done in one amazing feat?

A:  Make the intern pay! Have him work 
for months changing all of your 
legacy document. 

(if only this was an option, slave labor is 
banned in most states)

B: Modify the idw or dwg templates.

C:  Use the Document Resources Wizard
tool.

D:  Vault will save the day again.



C:  Use the Document Resources tool.

Believe it or not, we have had this tool
available for years.

The other tools would not get it done.

Changing the template files would only
have helped with future files. Not ones
already created.



Who do you blame if you see this?

A:  IT, they messed up again and moved 
the vault.

B: Your CAD manager.  He made a 
change to everyone’s project file and 
“pooched” the settings.

C:  Fred was crazy busy yesterday while 
trying to get away on his vacation.  
We are now finding what havoc he 
has left behind.

D:  Your wife, she was not happy with the 
Curvy part.
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C:  It is Fred’s fault.  He checked out 
files and never checked them back 
in again.  We all hope it rains on his 
vacation!

While the other choices would all have
given you problems. The key here is
that the file is checked out, not that it
can not be found.

vis2b



Vault has been used to copy a design. I
had a pot.ipt that I copied to pot-LA.ipt
However something messed up. I see on
my drawing it is still named “pot”. Also in
my parts list the old name lingers on.
What do I do? What went wrong?

A:  After copying a design, you must go 
into the iProperties and change the 
part number.

B: The settings in the Vault copy design 
dialog box needs attention.

C:  It is a setting in the application 
options dialog box.  Need to find the 
time to find it and fix it.

D:  By the time this is found out you are 
already home and can’t do anything 
about it until tomorrow, Nuts.



B:  The settings in the copy design 
dialog box needs attention.

If this has ever happened to you I really
feel your pain. This took me hours to
figure out. It was after 2am and my
reseller warned me that if I called him
again after midnight he would block all
my phone and email privileges.



Out of nowhere my sketching tools don’t
work the way they used to. I draw a
rectangle but it does not stay as one. I
can grab a corner and make funny
shapes. AUUUGGGGGHHHHH! Not so
FUNNY!!!!!!!!!!!!!!

A:  Someone is having fun at your 
expense and has changed your 
project settings

B: Someone is having fun at your 
expense and has changed your 
constraint settings

C:  Someone is having fun at your 
expense and has changed your 
application options

D:  Someone is having fun at your 
expense and has changed your 
drawing template file.



B:  Someone is having fun at your 
expense and has changed your 
constraint settings

OK, who ever hid these buttons is a
sadist. The first time it happens you
think you have lost your mind. After
trying all else (including reloading your
software) you call your reseller or CAD
manager, they will have a good laugh at
your expense.

Drop the Constrain tab down, turn these
two states back on, have a drink, go
home. Tomorrow is another day.



I have been working on my laptop with a
projector or dual screen setup. When I
go home I find out that dialog boxes are
coming up where I can’t see them.
Effectively I am becalmed. How do I get
the dialog boxes back into in my area of
view??????????

A:  ALT-space bar

B: It is your video card that is messed up.  
Go to IT and demand a new one.

C:  It is an Inventor issue, reload the 
software.

D:  Log the issue with tech support, they 
can fix anything.

Where is the Mirror 
dialog box that I just 

triggered?



A:  ALT-space bar

How many times do I wish I could have
tossed my laptop into the bathtub?
More than once! This was one of those
times.

Just press and hold the ALT key, then the
space bar. A small window will pop up if
you have a dialog box off your screen.
LMC the move button. Then press one
of you arrow keys. The dialog box will
appear under you cursor. Move it to
where you want, LMC again and get
back to work.



Now that the guys in logistics know we
can use iProperties to help create file
names, they have gone nuts. I was just
asked to include the name, material,
weight, size, price, delivery, designer, and
warehouse location. Don’t ask them
why, just let them know how many
characters can go into a filename.

A:  Any length you want, there is no limit 
in windows.

B: 128 - who would want to type more?

C:  1028 - because we can.

D:  256 - enough space to create a short 
story with a protagonist. 

assem



D:  256 - enough space to create a short 
story with a protagonist. 

Remember, our goal is sometimes just
making others happy.

Remember the path is included in this
character count



You get a part from a lazy designer. You
are asked to changed the 4-40 holes to
4-48. What should the last guy have
done to make this easier, or what can
you do now?

A: Rename the feature from Hole # to a 
name that has information

B: Set your selection tool to highlight 
feature names in the browser

C:  Hover over a feature name and see 
what is highlighted

D:  All of the above



D:  All of the above

Three Four possible methods, not in any
particular order:

1. Rename the feature as you would
file names in Windows. Click the
feature name, wait, then click it
again. The feature name will turn
blue and let you type in the
descriptive name.

2. Use the “Select Features” choice.
This will enable you to hover over
the feature and the name will
highlight.

3. Hover over the feature name, the
hole in question will highlight

4. Bonus – see next page



BONUS:

This is another of my favorites.

Notice in the browser the feature
names have descriptive details. This
saves me time.

To turn this on go to the Tools tab,
select Application Options, then turn on
the Display extended information check
box.
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You are going along, designing with joy in
your heart. Then BAM, your browser
goes away. Panic, Fear, Anger!

What do you do?

A: Call tech support, a reseller, your CAD 
manager, or even a 12 year old.

B: Give up, go home, take up knitting.

C:  Go to the View tab

D:  Re Boot, if that does not work, 
reinstall your software.
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C: Go to the View tab

Go to the view tab

Select User Interface

Turn the browser back on

Get back to work



You are working on a Vaulted document.
When you go to save it so you can check
it in you get “Save Copy As”

Note: You do not want a new copy, just
check in the model you are working on.
What do you do?

A: Don’t save, just close it.  Go home, 
find a new job.

B: Don’t save, Check the file out.

C:  Save outside the work space, then ask 
for forgiveness.

D:  Save with a new file name, then use 
Vault to change it back to what you 
wanted.



B: Don’t save, Check the file out, then 
save it.

Since you are being asked to save the
file with a new name, it means you have
not checked the file name out.

If you check the file out, you can then
save the file, and then check it back in
again.

When you opened this file from your
workspace you were asked if you want
to check the file out or it was not
available for checkout. If you chose not
to for some reason, or just a mistake,
then do as noted above. If you could
not check the file out, be careful before
writing over someone else's work.



I have a vendor that needs geometry
from my Inventor design for his AutoCad
drawing. What do I give him so his
drawing can stay current with my design
without having to redraw.

A: Go through Design Review with DWF 
files.

B: Save as AutoCad DXF. Both need the 
2014 release.

C: Save as an Inventor IDW.  Then it is a 
piece of cake.

D:  Save as an Inventor DWG. He will 
need the same release as you or 
later.



D: Save as an Inventor DWG. He will 
need the same release or later.



When you first create or place a file into
an assembly, what is this?

A: File Name

B: Nick Name

C: Part Number

D: Description
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A: File Name

When the file is first created or placed
the browser automatically uses the file
name.

Bonus:
If you want to change it you can. In the
browser you can rename the item. LMC
the name, wait, then LMC again. The
name turns blue and then can be
changed.

This does not change the file name of
the item, it is now a Nick Name.

Personal Bonus:
Explore the Productivity tools (assembly
tab) , You can change the Browser to
show Part number, filename or default.



You have a complex assembly with
hundreds of parts. As you were working
you turn off the visibility for some.
Without having to wander around the
browser, how do you make them all
visible again?

A: Use representation settings – set to 
Master

B: Use the binoculars

C: Choose File : Update : Visible : OK

D: Just close the file, then re open, all 
will be OK
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B: Use the Binoculars

Until recently I would wearing out my
browser. No longer. I had a great day
with my reseller while he watched me
work. Much to his credit he does not
laugh out loud. This was one of the very
cool tips he gave me!

The steps look a little overwhelming,
but don’t be put off by this.
1. LMC the binoculars
2. Drop down the Property box, in this

case I chose Visibility
3. Drop down the Condition box, in this

case I chose “is no”
4. Add to the search list
5. Find all that items that have visibility

turned off.
6. Close the dialog box
7. RMC one of the selected items to

turn visibility back on for all.
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I turned the visibility off on some lines in
my .dwg (or .idw). Now I realize I need
some of them. How do I make them
come back?

A: Close and open the drawing, they all 
come  back by themselves

B: Styles – set to “show all”

C: RMC – Show Hidden Lines and you are 
done.

D: RMC – Show Hidden Lines, then there 
is one more step



D: Use Show Hidden Lines, then there 
is one more step

If you just show hidden lines, then when
you cancel the command the lines
disappear again.

While the Show Hidden Lines command
is active the newly visible lines are red.
LMC on the ones you want to recover,
they will turn green. Then exit the
command. The green will turn back to
visible.



I wanted to use the “Contact Set” tool to
make sure the parts don’t go where they
shouldn’t. Problem, the contact set does
not work. Parts are passing through
other contact set parts. Why?

A: Contact Set tool is not turned on.

B: Enable Contact set function in 
application options.

C: The Contact Set tool is not used for 
this, it is used to measure surface 
area.

D: Contact Set tool will only work with 
two items at a time.



A: Contact Set tool is not turned on

After including items into the contact
set you must turn the tool on.

Go to the Inspect tab, then activate the
Contact Solver.



I am using a part from a vendor. I want
to use the content they provide to drop
into my model, The choices do not
include an Autodesk 3D format. What
would be the next choice?

A: Step

B: SAT

C: IGES

D: PDF



A: STEP

Choice in order of preference

1. Step
2. SAT
3. IGES (for surfaces)
4. PDF



I am working on this assembly when I
realize I am so overwhelmed by the
planes, points, and axes. I can’t see what
I am doing. How can I quickly make the
“noise” go away?

A: Turn off all workfeatures (planes, axes, 
points, ect.) one at a time.

B: Change Application options to hide 
workfeatures

C: Object Visibility under View tab

D: Document Options – Hide 
workfeatures



C: Object Visibility under View tab

If you uncheck the “All Workfeatures”
you are done. With the check boxes,
turn workfeatures back on as you need
them.



I am creating an animation of my
assembly. When I try to animate a
constraint I get this error. What is
wrong, what do I do next?

A: This assembly can not be animated, 
use showcase or 3DS Max instead.

B: Change Application Options - Set 
animation to YES.

C: The assembly needs to be corrected 
before animation is possible.

D: Don’t use Animate Constrains, try 
Animate Components.



C: The assembly needs to be corrected 
for enable animation.

This question comes from my first
attempt at animation. No matter what I
did I got this error.

My assembly had constraints that would
not work. Once I fixed them, I was able
to go too Studio to animate and export
videos.

Check your constraints with the Driven
tool. If you get errors with Driven, the
animation won’t work.

In the assembly, RMC the constraint.
Select Drive, then fill in the start and
end dimension. Hit play. If that won’t
work, figure out why, and try again.



I want to view my browser content
alphabetically. Wow, what a concept.

How do I do this, if I can?

A: Productivity

B: RMC - Sort

C: Can’t be done yet, get AUGI to help 
with the wish list.

D: Simplify



A: Productivity

This tool really made my day. I don’t
always use it, but when I need it,
AWESOME.



You are working with an assembly that
your customer wants to know that the
system will cost. Where could you keep
data that would help create a COG (total
cost of goods)?

A: Metadata

B: Engineer’s notebook

C: Styles

D: iProperties



D: iProperties

iProperty data can easily be exported or
used in conjunction with BOM to help
create a cost of goods sold.

One way to get to iProperites is LMC the
I at the top left of the Inventor Ribbon.

Select iProperties.

To get to a place to save the costing data
select the Projects tab, then fill in Cost.



How many projects (ipj) should, or could
have.

A: Definitely only one.

B: As many as you like, go crazy

C: It depends on how you are setup.  
Also who you ask.

D: Nuts, all of the above.



D: Nuts, all of the above.

If you are working with Vault Basic you
will be working with only one.

If you are not going to vault the data,
you can have as many as you like.

You can keep asking application’s
engineers until you get an answer you
like.



If my content is Vaulted, should I keep
the workspace copies?

A: Maybe, Only if you want to.

B: Yes, Vault will not work without the 
workspace copies in place.

C: No, you should delete them.  You 
should not have old copies of data 
that will mess up your Vault.

D: This is a trick question.  The 
workspace is not related to your
data.



A: Maybe, Only if you want to.

You do not need to keep your
workspace files if you don’t want to.
You can open the files from the vault
every time you need them. This way
the files will always be the current
versions.

However my work style forces me to
keep my workspace data. I have a
laptop and am constantly on the road. I
keep files on my local drive so I can
work where ever I am.

I then am careful about how I deal with
data in my vault at the office.
That topic is more than can be covered
here.



I want to share my assembly with a
colleague. He is far away so I need to
send him the files. When he gets the
data he will be working with the files in
Inventor. How do I send him the data?

A: Export a DWF complete file.

B: Trick question, you only need to send 
him the .iam file.  What could be 
simpler?

C: Pack and Go

D: Export as a STEP or SAT file.



C: Pack and Go.

Pack and Go gets it done.

LMC the I located on the top left of the
Inventor Ribbon.

Hoover over the Save As command, the
additional menu opens up, select Pack
and Go.

You then save as complete a copy of
your assembly, parts, and linked files (if
you want) as you need.

Your colleague will be able to work with
the resulting copy as if working on your
original.



A: JPG, TIFF, GIF

B: TSA, DEA, DOA

C: PNG, BMP, PDF

D: How foolish, none of the above.

assem

Which files are CAD
Usable 3D files?



D: NONE of those were CAD files.  

Here is a list of files types that Inventor
will open.

Never Trust a Cat



In a perfect world all Inventor users
would have the current version. Since
this is not the case, how many versions
back can you save Inventor files?

A: One.

B: Two.

C: All the way back to Inventor10.

D: The Rolling Stones said it best, “You 
can’t always get what you want”.

assem



D: The Rolling Stones said it best, “You 
can’t always get what you want”.

Sorry, there is no saving backwards.
Even if you believe in Santa, it won’t
happen.

The way I have worked around this is to
save my parts and assemblies as STEP
files. This solution does not give the
recipient an assembly with history,
constraints, properties and more.
However they can place the model and
use it as drawn.

Bah – Humbug !



I work for a small company. We have just
bought a new server for engineering
(amazing but true). Now we need to
move the “file store” to the new server.
What can I do to save time and money?

A: Simple, copy the “file store” and just 
paste it in the new server.

B: Move the workspace, then tell the 
ADMS were the new home is.

C: Check out the entire Vault to your 
workspace, Create a new Vault. 
Check in the workspace to the new 
Vault.

D: This is not a good time to experiment.  
Call in an expert and be done 
without major problems.

assem



D: This is not a good time to 
experiment.  Call in an expert and 
be done without major problems.

Yes, there is enough documentation out
there to help you move your file store
without help. However since this is not
what you do, This is a time you should
pay for help. Think of it like fixing
pluming in your house. If you get lucky
it will go well. If it goes wrong, it can go
very wrong.

If you are going to tackle the task, just
make sure you backup your Vault and
save the data someplace safe.

vis2b



You are going to be using this T slot over
and over again through out your
company’s tooling catalog. How do you
best capture this detail so it can be used
quickly and by more than yourself?

A: A fine time to learn how to use 
iFeatures.

B: Copy and save the sketch.  Save the 
sketch as an ipt.  

C: Vault the tooling plate, then use copy 
design to reuse the detail.

D: iLogic will save the day. Spend some 
time with the tool to find out why.



A: A fine time to learn how to use 
iFeatures.

iFeatures are so under utilized. Learn
how to use them. That’s an order!

For a bonus question (worth no points):

Is the feature used associative back to
the iFeature?? So if you make changes
to the iFeature will it update where it
has been used previously?



What is the Inventor equivalent of
AutoCad’s Dynamic blocks?

A: iParts

B: Sketchs

C: Sketch Blocks

D: iSketch



A: iParts

The iPart tool is so powerful in so many
ways. Once I started using it I have
found so many applications. Take the
time to experiment and fit it in to your
daily workflow.

Note:
You can also create Inventor Sketch
Blocks, these are very different from
iParts. These are similar to skeleton
modeling
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I needed to change my iPart parent. In
this case I am adding a new feature, a
c’sinked hole. When will the assemblies
that use a child of this iPart get updated?

A: When I save the parent

B: When I open the assembly or drawing

C: When I close the parent

D: When the children are generated



D: Generate Files

The children do not change until they
are generated. So after you modify the
parent. Select the children to be re-
generated and then make it so.



When I create an iPart, what does
making a value Key do?

A: Effects what is constrained when 
placed.

B: Relates to iProperties. What can be 
saved or not.

C: Determines what details are allowed 
to be configured when the part is 
being placed.

D: Enables you to sort values based on 
Key.



C: Determines what values are allowed 
to be changed when the part is 
being placed.

In this case I have only one value that is
important during placement, the length
needed. So I make only the Length
value a Key.

If all of the values are Key, you get a
much more confusing Place dialog box.



I want to give my purchasing department
a spread sheet with items needed,
estimated cost, and possible vendor.
How do I generate this spreadsheet?

A: Vault comes to the rescue again.

B: BOM and iProperties.

C: Create a drawing, then use the Parts 
List tool.

D: Hire an intern, have him go through 
the assembly.



C: BOM and iProperties

After you add the iProperty columns
you want, then export your BOM as an
Excel spreadsheet.

1 – go to the Manage Tab
2 – Select the Bill Of Materials
3 – Select BOM Export
4 – Select the format to export



Frequently Used Subfolders are great for
getting around your work workspace
faster. No longer having to wander
around opening folder after folder.
Where do you go to set them up?

A: Application Options

B: Document Settings

C: Project File

D: Windows operating system

assem



C: Project File

The Project file is where the Frequently
Used Subfolders are setup.

If your project file has been vaulted and
checked in, you must first check it out.

RMC the Frequently Used Subfolder
heading, then select the modification to
the folders.

Once you create a new folder, make
sure you give it a name other than the
default “folder”.



In the Projects dialog box, what does this
button do?

A: Gets you to the Configure Content 
Center Libraries dialog box

B: Gets you to the Configure your
libraries dialog box

C: Share your Project file with the rest of 
your team

D: Launches a counter attack on the 
marketing team of the company.



A: Gets you to the Configure Content 
Center Libraries dialog box



What spreadsheet programs can you use
to work within Inventor?

A: GoogleDocs

B: OpenOffice

C: Excel

D: All of the above



A: Excel

One of those times when the choice has
been made for you.



You have a customer that is trying to
move faster than he should. He needs
about 30 different adapters. The thread
stays the same for all, the heads vary.

He knows the head dimensions, just the
thread form has not been finalized.

Since he is in a rush, he wants you to
start now. Draw all the parts with the
same thread, then fix them all later
when that details are finalized. From the
tools below, what could help you get it
done in a timely manor.

A: Design Accelerator

B: Excel

C: Design Assistant

D: Vault

assem



B: Excel

Parameters come to the rescue.

You can setup User Parameters that are
linked to a spreadsheet. If the
dimensions of the thread form are all
linked to the same spreadsheet all the
parts can be changed at one time.



The green corners around the drawing
views denote that the image is in Raster
View Only or not completely calculated.
The views are now not as sharp and clear
as they could be. How could this
happen?

A: Setting in Application Options.

B: Document Settings setting.

C: Drawing View Setting.

D: Could be any or all of the above.

assem



D: It could be any of the above
Besides not being done calculating:
The raster view is selected
by the Memory Mode Settings.
This can be effected by:

1 - Document Settings

2 - Application Options

3 - Drawing View

vis2b



I would like to get a quick reverse
engineered version of a sample piece.
How can I get this done in a few
minutes?

A: Send it out for a Laser scan

B: Send it out to a company with a CMM 
to get the geometry data

C: A Smart Phone and a sketch

D: Graph paper and a ruler.



C: A Smart Phone and a sketch

While in a sketch you can import an
image. Then trace over the photo,
scale, and extrude. Done in minutes!



Jeff Richlin
Richlin Machinery Inc
40 Allen Blvd
Farmingdale NY 11735
jrichlin@omni-turn.com
(631) 694-9400

The questions and answers will be available on the AU class website, they will also
Be available for download at: http://www.engineeredtoorder.com/au2013.htm
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